Getting Started with Second Life

Maggi Savin-Baden, Cathy Tombs, Coventry University

Dave White, University of Oxford

Terry Poulton, Sheetal Kavia & Luke Woodham, St George’s University of London
Second Life is a free 3D multi-user virtual world developed by Linden Labs in 2003, and is inhabited by millions of residents across the world. It is used as a platform for education by many institutions, such as colleges, universities, libraries and government entities, with over one hundred regions used for educational purposes. This ‘Getting Started with Second Life’ guide is aimed at those who are wanting to use Second Life for teaching in further and higher education. It provides in-depth descriptions of all aspects of the immersive world for both direct use and facilitating others’ use.

Welcome to the Getting Started in Second Life guide! The guide has been written by representatives from several projects from within JISC’s recent Users and Innovation programme, which gave project teams the opportunity to work in emergent technology spaces that at the time were the domain of very few in higher education. These included multi user virtual environments such as Second Life.

Through a structured community and careful brokering of connections both in the UK and internationally, a group of projects came together that looked at these then only potential learning spaces and tried to make sense of them for an already busy higher education market. Their results and outputs far exceeded those laid down in their project plans, and are a testament to not only the projects’ own hard work, but the help and input of a wide range of other U&I projects whose staff volunteered their time to user test and participate ‘in world’ with events and exercises.

Through the life of the Second Life projects information was gathered and analysed and, perhaps unsurprisingly, one area stood out as needing support more than any other - getting started. This then gave weight to the argument for a JISC Introductory guide to Second Life. And here it is: aimed at staff who are looking to connect through a virtual world to learning and research activities, this guide should be the first step in any proposed use of Second Life for learning and teaching, providing a step by step approach and a range of guidance in the key areas and issues.

Lawrie Phipps
Programme Manager,
Users and Innovation Programme
JISC
Contents

Introduction ..........................................................................................................................................4

Getting started ......................................................................................................................................5
  Signing up and creating an avatar
  Stepping into Second Life
  After logging on
  Orientation
  Creating a presence in-world
  Movement
  Communication: three ways
  Teleporting

Next steps ..............................................................................................................................................9
  Interacting with objects
  Maps
  Playing media
  Inventory
  Personal profile

Beyond the basics ................................................................................................................................12
  Building and scripting
  Building
  Scripting

Designing courses in Second Life ........................................................................................................15
  Background theory of facilitating learning

Facilitating learning in Second Life ....................................................................................................18
  Getting started as a facilitator

Common mistakes and assumptions ....................................................................................................20
  Common mistakes
  Misguided assumptions

Practical concerns for your institution ................................................................................................23
  Automatic updates
  Computing power
  The ‘game’ problem
  Batch naming and registration
  Ethical issues
  Buying islands
  Permissions
  OpenSim
  Gaining support from senior management
  Supporting staff
  Using external support

Useful links and books .........................................................................................................................26

Glossary ...............................................................................................................................................27

Abbreviations .......................................................................................................................................29

References ...........................................................................................................................................30
Introduction

The first thing that everyone notices about Second Life is that it is a 3D graphical world which appears to be populated with pseudo-realistic humans with perfect bodies and elaborate hairstyles. This is quite an accurate description of the ‘virtual world’ which started to become popular in 2006. However, the graphical nature of Second Life can distract from the fact that it is not a single technology, but a range of online tools which cluster around a visual centre such as communications tools, 3D design tools to create or modify, and a scripting/programming language. Second life is also a ‘world’ with its own financial system complete with a currency and the ability to trade goods and services. It has a navigation/map system for travelling around and a ‘search’ system for finding people and places, like shops. It also allows you to choose how you look and what you wear, so that you possess both an inventory that contains everything that your avatar ‘owns’ and an expandable set of ‘gestures’ that allow individuals to animate their avatar’s movements or expressions.

This guide offers a basic overview of how to get started along with some tips on how to facilitate learning in this space. One of the difficulties with Second Life is that there is too much to learn by going through every menu or button systematically. It is better to pick up a few basics as outlined in this guide and experiment, rather than to get lost in the pursuit of mastering the detail of the environment. As you explore you may experience some of the following:

- It feels very lonely not being around other avatars and although some of the environments are visually appealing, you start to feel that the point of being in Second Life is maybe to communicate with others.
- It’s easy to get lost ‘teleporting’ around from island to island. You get a sense that there are some really interesting locations in Second Life but that you just can’t find them. Most of them seem to be either deserted or a disco.
- You have trouble flying and sitting down.
- People tend to notice you are new to Second Life because of:
  - Your clothes
  - The way you move
  - The language you use

You notice that your avatar’s appearance is like a huge badge that says ‘I don’t know what I’m doing’; you become slightly envious of those around you with a more individual appearance and begin to wonder how they acquired their impressive hair and clothes. This leads to an extended period of playing with your avatar’s ‘appearance’ settings, which ends with it looking slightly less ‘default’ but still fairly unpleasing.

- You get the suspicion that everyone else is role playing and that they can’t be fully trusted. You feel that everyone else is simply using the environment to play out fantasies and that their avatars are unlikely to be an accurate reflection of their real life bodies or personas. This seems intriguing but ultimately false. At this point you have forgotten that you made your avatar a 7’2’ fireman.
- You hope nobody starts talking to you.
- You try to build something but find you can only produce boxes and you just keep getting stuck.

First impressions vary but the point that’s being made here is that Second Life encourages individuals to think and act socially. Most people get a powerful sense of being present with other people in Second Life and while the graphics are in no way ‘realistic’, their level of detail appears to be enough to trigger social
and interpersonal responses. These types of environments have been described not as 'virtual reality' but as 'good enough' reality, to the extent that individuals carry many real life social codes into Second Life. For example, individuals tend not to place their avatar too close to another as they feel that avatars have a form of personal space. There has also been criticism (particularly by people in the gaming field) that the graphics are poor and laboured. However, we believe that as Second Life is being used for educational purposes this is not of great concern.

**Getting started**

This section gives a basic overview of the things you need to know to begin using Second Life. It is a stage which is found to be challenging, disarming and problematic by both staff and students. It is helpful to bear in mind that Second Life is more than a piece of software; it is also home to a loose form of culture with its own codes of conduct and forms of communication. The environment has attracted those looking to experiment with identity, building, sex, fashion, business, art and science. The practice of learning and teaching is just one of the many aspects of real life which is finding its way in Second Life alongside an intrepid population of early adopters.

**Signing up and creating an avatar**

With Second Life you have a choice of two types of accounts when signing up: the first is a free membership and the second a premium membership which is charged on a monthly basis and entitles you to become a land owner. Most universities that have land in Second Life have a premium membership and therefore as an individual you will just need to sign up as a free member.

**Naming yourself**

With every virtual world you need to sign up to create your virtual presence known as your avatar. When signing up to Second Life you must create a name for your avatar. The first name is any name you wish, but your second name must be selected from a given list.

**Creating yourself**

At the same time you must select an appearance for your avatar, and this is important as your appearance can say a lot about you in Second Life. It is important to note that you are able to change your appearance countless times by using the appearance editor and by using the numerous readily available shapes and outfits in your inventory.

**Stepping into Second Life**

After creating an account you need to download the Second Life application and ensure that your system has the minimum requirements to run it. [Information on this can be found at http://secondlife.com/corporate/sysreqs.php.]

**After logging on**

At the top of the screen there is a classic drop-down menu bar from which you can control the Second Life settings. One of the important options is in edit preference and world environment settings. Along the bottom of the screen there are shortcuts to some of the options such as chat (the first button on the bottom
Getting Started with Second Life

left), flying, search, maps and most importantly your inventory. Above your inventory button, you will notice a few more buttons and these are for voice chat, playing media and audio and volume control for all.

Orientation

The first place you will arrive is Orientation Island, in common with everyone else new to Second Life (this can be hard work and time consuming). Some universities have their own spaces to which direct teleporting is possible. The means of doing this is discussed in the ‘Practical concerns for your institution’ section.

On Orientation Island you will be prompted to begin a tutorial which will teach you some of the basics capabilities you will need. To enter the mainland of Second Life you must find the exit in the Orientation Help Island. Things to note:

- Collect note cards from the Orientation Island which will remind you of functions learnt there, because once on the mainland you will be unable to return to the Orientation Island. There is however a replica of the Orientation and Help Island on the mainland which can easily be accessed
- Browse your preferences options in the edit menu so that you can make the most out of your experience in Second Life. There are settings which control the way you see the world, and controls for functions such as media and audio
- Try to take time each week to become familiar with Second Life, as this will increase your confidence in the programme and will be particularly important when trying to facilitate in-world activities
- Learn to use your voice controls on the microphone and speakers/headphones
- Search buttons are very useful for finding different places, islands, events and people on Second Life. The main map is always useful for finding your way around Second Life and the mini map is useful for finding your way around your current location

Figure 1. The Second Life interface
Creating a presence in-world

Once you have had enough time to get to know the Second Life interface and applications, creating your own presence in-world is a good idea. In practice this means moving away from being a ‘newbie’ [a new in-world person]. Most ‘newbies’ are easily recognisable from their standard set appearance and most advanced users are seen to have more adventurous costumes. The way you look in-world says a lot about you. To create a presence you play with your appearance settings and editor, which will not only impress the students you are facilitating, but also enable them to see that you look different from them, and identify you. Sometimes it is easier to spot the facilitator when in large groups if the facilitator is somewhat different from the rest.

Movement

To move your avatar in Second Life, use the up arrow key to walk forwards and the down arrow key to walk backwards. The left and right keys rotate your avatar on the spot. Press ‘Page Up’ to make your avatar airborne, and ‘Page Down’ to lower it back to the ground. The arrow keys move your avatar in the relevant direction whilst flying. You can also use your mouse by clicking on buttons on the movement menu.

Communication: three ways

1) Local Chat

Avatars within a ten-metre range of each other can communicate via the Local Chat text box. Type content into this box and press ‘Say’ to speak to other avatars. You can also choose the option ‘Shout’, which has a louder range if you want avatars further away to hear you. To view a history of all chat, click the ‘local chat’ button.

2) Instant Message

The second way of communicating in Second Life is via private Instant Message. Click the ‘Communicate’ button at the bottom of the screen; choose the ‘Contacts’ tab and then select whichever avatar you wish to talk to from the list of ‘Friends’ or, if you wish to communicate to a number of people, ‘Groups’. Clicking the IM/Call button on the right brings up a window in which you can chat privately to another avatar.
3) Voice Chat

The third method of communication is via voice chat. If a person has a microphone and speakers/headphones, their voice will be projected into Second Life so that those who have voice chat enabled will be able to hear them and can respond accordingly, either by text or voice as well. To enable voice chat, go to Edit > Preferences > Voice Chat and tick the box. A button at the bottom right of your screen will then appear labelled 'Talk'. By holding down this button, other users in Second Life will be able to hear your voice, provided your microphone is plugged in. Like Instant Messaging, you can also have a private voice conversation with a contact.

Teleporting

Teleporting in Second Life is a convenient and quick way to get from one place to another, whether it be in the same region or an entirely different region altogether. To use a teleport, right click and select ‘Teleport’ from the menu. Some objects are scripted so that a simple left click can also teleport the avatar.
You can also be offered a teleport from another avatar to their location, which will appear in a popup on the top right corner of your screen. Similarly, you can teleport a contact to your own location by visiting the ‘Communicate’ menu or their profile.

**Next steps**

This next section gives advice about how to go beyond just moving, getting dressed and communicating in Second Life, and will help you to explore the medium more fully.

**Interacting with objects**

There are many objects within Second Life that are scripted to allow interaction between the object and the avatar; for example, touching a door will open it. These objects can be interacted with by right clicking and selecting ‘Touch’ from the menu, or simply by left clicking.

To sit on an object, right click and select ‘Sit Here’ from the menu. Occasionally chairs and sofas have ‘pose balls’ visible and left clicking on these will seat your avatar.

![Figure 5. Preparing to sit down](image)

To return your avatar to a standing position, click the ‘Stand Up’ button at the bottom of the screen or right click the object and select ‘Stand Up’ from the menu.

Objects occasionally also give note cards or landmarks when you touch them. Note cards are an extremely useful way of receiving information in Second Life. When touching an object that offers a note card, you can touch either ‘Keep’ or ‘Discard’. Choosing the option ‘Keep’ opens up the note card for viewing. However, be careful what you accept, as some note cards can result in spam mail, particularly those relating to gambling areas of Second Life.

**Camera angles**

To change your view on screen, you can change the camera angle. Use the scroll wheel on the mouse to zoom in and out. If you zoom in to the maximum level then you will enter ‘mouselook’ mode which allows you to look around using the mouse from the avatar’s perspective. Another option is to go to View > Mouselook at the top of the screen. To exit mouselook mode simply zoom out again using the scroll wheel, or press the Esc button.
If you press and hold Ctrl + Alt and hold down the left mouse button whilst moving the mouse around, you can point the camera in all directions, giving a much better viewing experience. You can also use the camera movement tool by clicking on the buttons to move the camera around.

Maps

A useful tool in Second Life is called the ‘Mini Map’, located in the top right corner of your screen. The mini map shows the entirety of the island where your avatar is located, as shown below in Figure 7. The grey represents objects, the blue represents objects your avatar owns and the purple are group-owned objects. The yellow dot is your avatar, and any green dots scattered around represent other avatars on the island.

You can also open up the ‘World Map’ from View > World Map, which can show all the other regions around the one where you are located, as well as land for sale, events, info hubs and more. You can use the World Map to find a different region by typing a location or name into the search box.

Playing media

Media is an integral part of Second Life with constant sound effects and music. The buttons at the bottom right of the screen are used to start and stop the media and adjust volume. Videos are also streamed into Second Life, onto screens dotted around certain locations.
As you can see from the icons in Figure 8, a video is currently being played but the greyed out music icon means there is no additional sound available.

**Inventory**

Any objects your avatar might make or pick up, as well as note cards, landmarks, bought objects and textures, are placed in your avatar’s ‘inventory’. When first joining Second Life, the inventory comes with pre-made objects, textures, landmarks and more, but you can continuously add to it, by either buying new items or creating your own. Landmarks and note cards are always free and go automatically into the relevant folders.

![Figure 9. Example of an inventory](image)

You can search the inventory for objects you might need by typing the name or part of the name of the object into the text box at the top, or searching for your most recent items.

**Personal profile**

When in the same region as other avatars, you can view their profile by right clicking and selecting Profile. Likewise, you can click on your own avatar to edit your profile. Profiles are a good way to let other avatars know what you are interested in, where you might frequent and what you do in your spare time. The amount of information you put in is entirely up to you, but it would be wise not to be too personal, as anyone can view your profile.

![Figure 10. Avatar profile](image)
Beyond the basics

This section is for those who want to do more than use the space for learning and teaching, for example, using problem-based learning or small group teaching. It will guide you through the process of basic building and help you to understand what scripting involves and how to do it.

Building and scripting

A significant factor in the appeal of Second Life for many universities is the ability to build in the environment. Across Second Life nearly all the content in the environment is designed and built by those using it, including buildings, vehicles and avatar attachments such as clothes, jewellery and certain hairstyles. Once an object has been built, interactivity and behaviour can be added to it using scripting.

There are a great many resources available on the web that provide tutorials and guidance for content creation in Second Life. Two of the most comprehensive, which represent good places to start, are the Second Life Support Centre (http://support.secondlife.com), which offers an extensive knowledge base of common questions and solutions, and the Second Life wiki (http://wiki.secondlife.com) which offers tutorials for building and scripting, templates for object and code design, and a complete reference to the Second Life scripting commands and syntax.

Building

Second Life provides tools for building and modifying objects as part of the standard Second Life viewer, so no additional software is required. These tools are relatively simple and do not contain the advanced options provided by dedicated 3D modelling suites such as 3D Studio Max and Blender. This approach ensures that it is relatively simple to build basic objects, although a certain amount of ingenuity and creative thought is required to model more complex shapes using the basic tools available.

In order to build it is necessary to have access to land on which building (or ‘rezzing’) is permitted by the landowner. This may be land that is personally owned or land that is designated as a public ‘sandbox’. A sandbox is an area that has been made available for building and testing objects, and many are made publicly available to allow residents that do not own land to develop their building skills. A number are provided by Linden Labs, and can be found by typing ‘sandbox’ into the region search field on the map screen.

Objects in Second Life are constructed out of constituent parts known as primitives, or ‘prims’. There are 15 basic prim shapes (Cube, Prism, Pyramid, Tetrahedron, Cylinder, Hemicylinder, Cone, Hemicone, Sphere, Hemisphere, Torus, Tube, Ring, Tree, Grass) which can be rezzed from the Second Life building interface. Having rezzed an instance of a prim, numerous modifiers can be applied to alter its size, form, position and orientation. Objects can be moved using the axes displayed around the object when it is selected for editing. Holding the Ctrl key changes these move handle axes into rotate handles, and holding Ctrl and Shift brings up stretch handles. With these handles displayed the mouse can be used to manipulate the object. Further transformations such as twists, shears and hollowing can be applied by modifying the parameters under the Object tab on the building dialog box.
When first rezzed, all prims are displayed with a default wood grain texture. This texture can be changed, along with the colour of the object. New textures can be obtained from many in-world sources, and a library of default textures is accessible to all avatars. External image files can also be imported for a small fee of 10L$ (Linden Dollars), enabling photographs and other images to be displayed in-world. Multiple textures can be applied to different faces of an object, and the orientation and repetition of these textures modified to achieve the desired effect. The appearance of textured objects can be modified further by adjusting parameter values that determine their transparency, shininess and luminosity/glow.

Combining multiple prims allows more complex objects to be created. The constituent prims can simply be positioned relative to each other to give the visual impression of being a single object. In cases where the object is intended to be inanimate or for scenery such as road sections, this is perfectly acceptable. However, when an object consisting of multiple prims is required to be moved or scripted in some way it is usually necessary to link the objects together so that actions and movements act upon the object as a whole. Moving a linked object will cause its position in the environment to change, but the position and orientation of the constituent prims relative to each other will remain unaltered. A linked object takes a single ‘root’ prim as its reference point for determining its position, and this root prim also acts as the content holder for any scripts or objects to be included within the object. The identity of the root prim is determined by its having been the last object to be selected before the command to link the objects was given. When an object consisting of linked prims is selected the root prim will be highlighted in yellow, while all other prims are highlighted in blue.

Objects also have a number of properties which can be altered. These settings can have a bearing on how the object responds to events and actions in the surrounding environment, and include properties such as an object being temporary (causing it to be deleted after having been rezzed for a short period), flexible (causing it to move or bend according to wind conditions and gravity) or phantom (allowing avatars or other objects to pass through it without a collision occurring). Objects can also be made physical, which imposes a more sophisticated and realistic set of physical constraints upon the object, ie the object is subject to gravity and other forces which are not applied to non-physical objects.
Scripting

As a complement to its building tools, Second Life provides a scripting language which allows residents to add behaviours and interactivity to the objects that they create. Linden Scripting Language (LSL) is a language specifically designed for Second Life. It follows many of the conventions associated with full-featured programming languages, and is structurally similar to Java and C. There are numerous LSL examples and tutorials available both on the web and in-world. The LSL Portal [http://wiki.secondlife.com/wiki/LSL_Portal] on the Second Life Wiki provides a comprehensive reference to the LSL language.

For a script to be active and able to run it must be contained in an object that is rezzed in-world. Scripts contained in inventory, whether inside an object or on their own, cannot be run. A script, when activated, will influence the behaviour of its container object. It may cause the object to move in position and/or orientation, change form, display text, change appearance or send messages. A script can also determine how the object responds to external stimuli, such as being touched by avatars, colliding with other objects, or hearing messages. Particle effects such as snow, smoke or steam can be generated by using scripts to rez many instances of very small objects. Similarly, larger-scale objects can be generated by scripts where required.

Scripts are written using the editor built into the standard Second Life viewer. This editor is brought up by double clicking a new or existing script, and acts much like a conventional text editor, allowing code entry and editing.
As with all languages, there are conventions of style that should be followed when creating scripts. These conventions help to ensure that code can be easily understood by developers who need to use or adapt other developers’ content. A document detailing the key guidelines for coding style can be found at http://wiki.secondlife.com/wiki/LSL_Style_Guide, and includes guidance on code layout, variable naming conventions and code separation.

Before a script can be run it must be saved and compiled. The compilation process generates an optimised, non-human readable version of the script, but this process can only be completed if the script is free from errors. Attempting to save a script containing errors will result in the compilation process failing and a description of the first error encountered and the line number on which it occurs being output to the editing tool. Repeatedly attempting to save a script and tackling each error in turn is often necessary before a script will pass the validation checks and save successfully. However, in some cases the line numbers that are indicated by the tool can be misleading when it comes to identifying the location of an error and the steps needed to resolve it. For instance, an error may be detected by the tool upon reaching a certain line, but this may be caused by the omission of a closing bracket or semi-colon on a line further up in the script.

Designing courses in Second Life

Whilst theories of learning have never been static, the distinction between and across the approaches – behavioural, cognitive, developmental and critical pedagogy – continues to be eroded. There is increasing focus in the 21st century on what and how students learn, and on ways of creating learning environments to ensure that they learn effectively – although much of this remains contested ground. New models and theories of learning have emerged over the last decade which inform the development of learning in Second Life. For example, the work of Trigwell et al. (1999) on teachers’ conceptions of learning offers useful insights into the impact such conceptions have on student learning. Yet, the work of Meyer and Land (2006), Haggis (2004), and Meyer and Eley (2006) have been critical of studies into conceptions of teaching and approaches to learning. Thus with the shift into Web 2.0 technologies, and the increasing focus on learning and interaction through social networking, it may be advisable to develop academic regulations that fit
more effectively with these approaches to learning than the objectives model of education. For example, a learning outcomes model of education has a behavioural focus in terms of what the students must do and what content they must cover, what is measurable and recordable. This model is teacher-centred. Perhaps it would be increasingly appropriate to adopt a more flexible approach when designing courses for Second Life, that reflects the principles and practices of social networking. An example would be the intentional model of course design, which focuses on a notion of responsible learning embracing the idea that learning, rather than teaching, is central to higher education. It is a student-centred approach, so it is the ‘intentions’ of the teacher that are described, what the teacher ‘expects’. The focus then is on multiple models of action, knowledge, reasoning and reflection, along with opportunities for the student to challenge, evaluate and interrogate them. Thus in this model effective teaching is designed to change society in substantive ways.

The idea then would be to utilise the notion of learning intentions rather than objectives for Web 2.0 curricula. Theoretically this is based on both Stenhouse (1975) and Pratt et al. (1998) combining Stenhouse’s notion of ‘induction’ and Pratt’s notion of Social Reform. This would provide a different course design rhetoric which is more resonant with many of the practices we actually use already and allow for the possibility of ‘regulating for flexibility’. Thus, the curriculum becomes based upon the idea that knowledge is contested and speculative, and thus although content is specified there is not necessarily disciplinary structure. This learning intentions model focuses on equivalence of experience, since in any system of higher education it is not ultimately possible to ensure equity. The focus is on quality learning, whilst acknowledging that quality is not unproblematic.

**Issues of facilitation or course design?**

Early work on exploration of the role of different staff was carried out by Peters (1998), who identified five types of course design teams for distance learning, which are summarised below:

**Type 1:** A university lecturer who is solely responsible for developing and running an online course. They may have had some experience of online learning but may not have worked as part of a team or know the literature on online education.

**Type 2:** A university lecturer who co-authors with educational technologists.

**Type 3:** A learning technologist or a group of learning technologists who are responsible for developing a course.

**Type 4:** University lecturers, learning technologists, graphic designers, editors and media specialists who work together as a course team and develop a course for which they are jointly responsible.

**Type 5:** An expert online teacher and experienced faculty member who is aware of the educational and technical issues of online learning, and uses the support of a learning technologist for preparation of course materials.

These are the delineations of the types that are often seen in the design of immersive virtual worlds programmes. What tends to happen most often is that the education drive for developing immersive virtual worlds comes from the Type 1 facilitators, who then seek support from one another and maybe also a learning technologist. The module or course is thus pedagogically driven but the materials are not always well designed in terms of learning technology. This then introduces issues as to what counts not just as good design but also as good facilitation.

**Background theory of facilitating learning**

In earlier texts the notion of facilitation at different levels has been discussed and in particular what might count as effective facilitation. Salmon has provided a comprehensive guide to ‘e-moderating.’ An electronic
moderator is someone who ‘presides over an electronic online meeting or conference’ [Salmon 2000:3]. She draws on research from staff and students’ perspectives, offers guidance on training e-moderators and suggests a useful model for teaching through computer-mediated communication.

Carlson’s definition of a moderator online is one who:

“Helps people get started, gives them feedback, summarizes, weaves the contributions of different folks together, gets it unstuck when necessary, deals with individuals who are disruptive, or get off the track, brings in new material to freshen it up periodically, and gets feedback from the group on how things are going and what might happen next...[Further the moderator needs to] communicate with the group as a whole, sub-groups, and individuals to encourage participation.”
[Carlson, 1989: 6.11]

However, there has been little documented in the literature about the role of the facilitator in immersive virtual worlds. For some, there is an assumption that when eight students share a computer to engage with a scenario it is sufficient for a roving tutor to call round briefly to each team. Yet this does not mirror the current notions of immersive virtual worlds facilitation, and in many ways downgrades the role of the facilitator in an immersive virtual worlds team. A virtual model of facilitation that reflects some of the best face-to-face problem-based learning facilitation practices is required. So a facilitator could join in the email debates students are having and call in on discussions. Yet there are problems too with this in terms of staff time and students’ participation. For example, how do we deal with students who do not participate in immersive virtual worlds? How do we deal with colleagues who are too directive and interfere with the team process and progress?

In recent years there have been increasing debates about whether facilitation is just a form of good teaching or whether in fact it is something else [for example, Boud and Miller, 1996]. Heron [1989; 1993] has suggested three modes of facilitation that may be useful for helping us understand how facilitators consider enabling learning in immersive worlds. They are as follows:

The hierarchical mode: Here the facilitators direct the learning process and exercise their power over it. Thus they decide (however covertly) the objectives of the team, challenge resistances, manage team feeling and provide structures for learning. In short, the facilitators take responsibility for the learning that takes place.

The co-operative mode: The facilitators share their power over the learning with the team and enable the team to become more self-directed by conferring with them. The facilitators prompt the team members to decide how they are going to learn and to manage confrontation. Although the facilitators share their own views, these are not seen as final but as views amongst many.

The autonomous mode: The facilitators respect the total autonomy of the team; the facilitators do not do things for or with the team, but give them the space and freedom to do things their own way. Without guidance, reminders or assistance, the team evolves its learning and structure, finds its own ways to manage conflict and gives meaning to personal and team learning. The facilitator’s role is that of creating conditions in which students can exercise self-determination in their learning.

The modes are not designed to be discrete or hierarchical and do to some extent overlap with one another. These are useful guides, particularly when coupled with the further descriptions that Heron has added, but there are also some rather obvious and helpful issues that need to be considered when learning to be a facilitator in immersive worlds.
Facilitating learning in Second Life

One of the central principles of facilitating immersive virtual worlds is that until we understand our own pedagogical stance (i.e., what we believe and stand for in learning and teaching) it is difficult to operate effectively as an immersive virtual worlds facilitator. Thus, until we understand our own views about teaching and our ideas about collaboration in online spaces and are able to consider the issues of student responsibility, it is difficult to locate ourselves in these complex spaces. Therefore, a useful starting point is to ask yourself about how you see your position as a facilitator in immersive virtual worlds:

- How much guidance do I expect to give to the students?
- How do I expect groups to work?
- What do I believe are the students’ roles?
- How do I see the relationship between immersive virtual worlds and the rest of the curriculum?
- What is the nature of the problem scenarios used in problem-based learning and assumptions implicit within the construction of these scenarios?
- What do I see as the relationship between immersive virtual worlds and the assessment methods?
- How have I/will I create space that enables students to reflect upon individual and collective goals?

Some things to consider at the outset include:

- Ensure you know the scenario you are facilitating and also the learning objectives/intentions you would expect students to address in the session.
- Before you facilitate in-world, it is a good idea to try out the scenarios so you understand how they work.
- Know the target audience (in this case the students) who are going to be taking part in the session, so that you understand the level of knowledge they will apply to the scenario.

Getting started as a facilitator

Although it is possible to plan the programme well in advance and arrange for staff members to undertake an e-moderation programme, there are some principles of facilitating immersive virtual worlds that differ from other models of e-moderation, in which Second Life facilitators should:

1) Guide but not interrupt. There is a tendency, particularly at the start of a session where students are presented with a new problem or activity, to interrupt or even pre-intervene by asking leading questions before the team have had a chance to discuss the problem. For example, if there is silence some staff will begin the scenario for the students by asking a question. It is better to wait, or to ask a gentle question such as ‘what are the team thinking about this?’

2) Represent etiquette. Although much has been written on online etiquette (netiquette) there are differences in immersive virtual worlds, particular in relation to respecting silence, promoting student autonomy, and not interrupting when flaming occurs. This is largely because if facilitators interrupt or take control, the locus of control shifts to the member of staff and the team do not deal with the problem or conflict themselves. There is a delicate balance here, but it is important for staff to model this and also to help students develop ground rules for their own team.
3) Acknowledge and use prior experience. Many tutors feel that becoming a facilitator seems to be such a different role when they first begin that often they forget to draw on their prior experience. For example, one approach might be to reflect on the experience of being supervised in a research project. Often the supervisor guides the students in the early stages of the project, but towards the end the students may overtake their knowledge base. Another option might be to imagine the facilitator role as being that of a non-directive counsellor who uses reflection and questioning rather than direction.

4) Recognise that being a facilitator means also being a learner. This might mean learning to develop the capabilities of a facilitator and learning new knowledge with and through the students. The process of becoming a facilitator also demands developing and understanding the way in which facilitator and team influence one another in the learning process.

5) Ensure that the team’s concerns are heard. Active listening skills are a prerequisite to good communication and are one of the most effective tools for helping online teams manage conflict. There is often an assumption that ‘hearing’ what is occurring online is very difficult, but learning to read the subtext of discussion forums and chat sessions is a skill facilitators need to develop. Although this is complex to begin with, the ability to read team interactions in online spaces does develop over time.

6) Listen and lurk positively. There is often a tendency, after using straightforward online learning, to retain control rather than granting it to the students. The notion of ‘lurking’ often seems to imply that silence and watching are inherently bad, but students often need to watch and listen in immersive virtual worlds, so it is important not to confuse lurking with thinking space.

7) Provide supportive interventions. It is often easy to assume that not intervening means maintaining silence, but it is useful if students ‘know’ you are part of the discussion. Rather than just lurking it is helpful to students if the facilitators add some remark that illustrates they are listening and supporting the learning, but in a way that does not interrupt the students’ discussion. Although this is difficult, statements such as ‘I think this an interesting discussion’ or ‘would all the team agree with this?’ are useful general statements for supporting students.

8) Promote personal reflection. Rather than weaving and summarising the discussion as a facilitator, it is possible to encourage the students to reflect and summarise their own discussion and stances at the end of a given time period or problem. This encourages not only group reflection but also the synthesis of the process of what has occurred, as well as the synthesis of the information that has been collected and collated.

9) Encourage team criticality. One of the most difficult capabilities for students in immersive virtual worlds is in taking a critical stance. Many of those who have researched immersive virtual worlds report that there is a tendency for students to focus on the process of learning and the information collected, rather than taking a critical stance towards the way they are working and the knowledge produced (see for example Hmelo-Silver et al., 2006; Lycke et al., 2006). Ways of encouraging the development of criticality include suggesting the use of a team wiki, using blogs for assessment and asking students to summarise and critique each other’s contributions. The latter activity is very demanding of students and often difficult to do, but if the teams have been well supported and are cohesive this is often a possibility. One way of beginning this process is to use interesting activities within the team which are competitive, such as treasure hunts, but where the team themselves have to decide which team member wins and say why this is.

10) Use intuition. In the context of immersive virtual worlds little attention has been given to the role of intuition in facilitation. Arguments abound as to whether uploading handouts and detailed lecture notes onto WebCT/Blackboard is something that helps or hinders student learning. Yet both staff and students’ stories
of their experience of immersive virtual worlds would seem to suggest that intuition is very much part of the process of learning and facilitation. Facilitators often speak of knowing when the team is going well, and also of recognising times when there were difficulties in the team, although they could neither define nor verbalise how they knew these things.

Common mistakes and assumptions

Many of the difficulties related to the use of Second Life occur because of either complete unfamiliarity with immersive virtual worlds or a familiarity with gaming that tends to get in the way of seeing the educational value of this type of immersive world. A further common assumption is that it is easy, straightforward and possible to transpose real life teaching into Second Life; but to do so would be to mistake the educational purposes of this kind of learning. Thus building lecture theatres and presenting PowerPoint in-world is possible but is merely a replication of real-life practice. This section describes common mistakes and assumptions, both in order to prevent mistakes and as a way of pointing up that this is a very different educational medium from a standard and linear virtual learning environment that most universities use.

Common mistakes

1) Not setting up the learning properly

One of the most common mistakes staff make is just to give students coordinates of where to meet in Second Life and expect them to turn up there. There does need to be initial preparation such as:

- Setting up a Second Life group of your students
- Signposting and labelling an environment clearly
- Making sure that it is an active session and group activities are not just reading, which should be done on other platforms

2) Ineffective use of the space

There is tendency to impose real life teaching on Second Life, instead of thinking differently about what learning might look like in this space. Sometimes this means using activities that might not be seen as learning, such as building, and this in itself can be a helpful ice-breaker. At the same time there can be a tendency to over-structure, such as:

- Making orientation sessions too structured (squeezing the fun out of the platform). It is important to remember that a lot of Second Life has to be learned by experimentation, and not by following a list of functions
- Forgetting that Second Life is very new and that there is no ‘proper’ way to engage with it, ie it’s an emerging culture

3) Failing to provide students with basic guidance that will help them into the space more easily. Whilst some of these suggestions may sound obvious, it is surprising how often staff fail to:

- Teach students how to sit down!
- Show students how to use the mini-map
- Schedule a ‘warm-up’ and ‘cool-down’ time for students to chit-chat and socialise before and after sessions. Doing this will help them to negotiate the social challenges of Second Life
4) Failing to help students develop beyond the basics. It is easy to assume that once students can move and communicate that this is enough for a seminar, when in fact it is useful to:

- Be clear about the difference between Instant Messaging, chat and voice chat and how they can be used
- Encourage experimentation and play

**Misguided assumptions**

The following issues have emerged from discussion with staff, and arose from their experiences as both teachers and learners in Second Life.

**Collaboration is necessarily part of learning in Second Life and it is easy to set up**

The fact that individuals are represented by avatars in Second Life does not automatically aid collaborative work. Things to consider:

- That being ‘embodied’ by an avatar can lead to a heightened sense of being co-present with other individuals online – but not everyone experiences this
- The lack of non-verbal cues and the delays in communication caused by text or voice chat mean that Second Life struggles to support the kind of interpersonal cues and immediacy needed for close collaboration

These problems can be offset to some extent by the assigning of roles and tasks which facilitate a form of ‘in world’ team co-operation. This form of participation, in which individual roles are clear, is likely to be more successful in Second Life than trying to reproduce, for example, the equivalent of a creative real life collaboration session around a whiteboard. Once a group has been working in Second Life for some time they may develop strategies to aid closer collaboration, but this is a process of negotiation which takes a few sessions to develop.

**Voice communication via a microphone will be more effective than text chat**

In fact the lack of non-verbal cues and believable lip-sync in Second Life causes voice chat to present a sense of disembodiment of the avatars. This then generates a feeling that you are involved in a phone conference whilst looking at a collection of mannequins on screen. Staff experienced with Second Life tend to argue:

- The use of Second Life can seem nullified when voice is used, unless students are attempting a focused task in which their avatars become simply tools to achieve a goal, rather than an immersed embodiment of their persona
- The problem of the slight delays which the system suffers from and using voice chat can cause exhaustion and confusion similar to that of a traditional phone conference

Text chat has its own failings as it can be slow and fractured, but it is worth remembering that multiple people can type at the same time whereas only one can talk. An experienced group can communicate surprisingly efficiently using text chat, a communication paradigm that is becoming ever more part of our culture.
Getting Started with Second Life

Social pressures within Second Life will always be a problem

Second Life is a social space and all students will feel a need to distinguish themselves from others, and often to demonstrate their level of expertise relative to the environment they are in. This immediately leads to a preoccupation with hairstyles, clothing and general appearance. Ways around this include:

- Recognising that not looking like a default avatar or a ‘n00b’ is very important to many, so it is worth planning in time for students to play with their appearance before attempting any specific teaching
- Using appearance play as an ice-breaker can also help students learn some key basic skills (camera control, navigation, communication)

What you look like in Second Life is not that relevant to teaching (uniform, crazy hair etc)

It is a mistake to imagine that it is possible to use Second Life without aspects of social and identity issues coming into play. Avatars encourage a persuasive form of anthropomorphism leading even a small group of students on a private island to start to generate a ‘society’ which is concerned with more than just the learning in hand. If you are wary of this aspect of Second Life then it will be more fruitful to use a different platform, rather than to try and ‘lock down’ these effects of the virtual world.

‘Gamers’ will like Second Life or understand how to use it

Many gamers complain about the lack of ludic play in Second Life and the ‘lack of graphics; ‘they also tend to impose gaming tactics on Second Life activities. Gamers do use Second Life, but if used for educational purposes Second Life is generally not seen as a game. Often there is an assumption that ‘technical people will inherently understand Second Life’, which is not always the case!

Using Second Life in the same real life room will be easier than using it at a distance

There is little basis for this; the main difficulties with using Second Life do not relate to where you are sitting but are to do with the internet connection, the graphics card and computer specification. It might be easier to provide support tutorials with a group of students in a computer lab by wandering around the cohort, but after the initial orientation phase there is little advantage to this.

It is necessary to learn the whole platform set by step

Although there are some tasks that are useful for students to learn, such as gestures and movement, bridge-building and tree-building, it is often better to let students follow their motivations and learn through experience and experimenting to begin with. Fun activities can also help, for example Maggi’s student cohort at the University of Edinburgh was asked to buy an object in Second Life and sell it to the tutor for a profit. She didn’t win, but learnt a lot in the process and the person who won sold the tutor a ride-able invisible yak.

An avatar that is not moving is not doing something

The notion of lurking has emerged as a negative position from virtual learning environments, but is not really relevant to Second life. Watching, reflecting and waiting are all seen as acceptable avatar behaviours!
Practical concerns for your institution

Automatic updates

Second Life is constantly being updated and improved throughout its working life. This can cause problems for institution-wide installs on individual computers as, whilst staff members usually have the option to install and update software, students have extremely limited permissions. This problem could be resolved by creating a Start Menu shortcut that, when executed, runs Second Life remotely from a hard drive that is available to all computers across the institution.

Computing power

Second Life can be run on some computers and not others; http://secondlife.com/support/sysreqs.php details the system requirements and recommendations for running Second Life. The main components for Second Life to run at a decent speed are a good graphics card and plenty of memory, as well as a good broadband connection.

The ‘game’ problem

Depending on your institution’s attitude it may be important to distinguish Second Life from a ‘game’. Casual observers of Second Life often see it as a game and associate this with leisure, not learning. However, introducing the sceptics to educational projects in Second Life will likely give them a better idea of the possibilities of what one can do in-world.

Batch naming and registration

Second Life is a commercial platform; it cannot be controlled by a higher education institution. One example of this is the Second Life naming system, which makes it almost impossible to create avatar profiles on a large scale. It is best to take the view that the avatar profiles are personal to the students and that they happen to be using them for learning, rather than to try to get involved at an administrative level. The only thing required by the institution is a cross-reference list between avatar and real life names for tutoring and assessment purposes.

There is also an issue with IP addresses, meaning that only a limited number of students and staff can sign up to Second Life on campus. This problem can be resolved by setting students the task of signing up at home; of course this then brings up the issue of those who do not have internet access off campus.

Ethical issues

Second Life is home to numerous fringe groups and activities, just like the internet and the town in which your institution is based. Students are free agents in a free environment. The expectation would be that they should adhere to certain standards during learning and teaching sessions. However, at a more serious level it is important that there is a university agreement in place about ownership of university objects and spaces, so that issues of intellectual property do not become an issue.
Second Life reliability

Sometimes Second Life does not operate due to maintenance schedules and sometimes, as is the case with most ‘new’ services, it becomes unstable. If this happens there is no straightforward alternative and it is probably best to simply reschedule the session. However, Second Life does often let you know in advance if they plan maintenance and you can find out about the server status by visiting http://status.secondlifegrid.net. Some universities are developing web applications to compensate for this.

Buying islands

This involves the university buying space and then paying a monthly rental. This offers privacy and security in terms of building and teaching – although unless the island is kept as a constantly secure space it can mean you may have people wandering into seminars. Buying an island can be complex, as the island will be ‘attached’ to a single avatar which might be a member of staff who subsequently moves on. Thus it is best for it to be attached to someone fairly senior in the organisation. However, technically you do not need to own land unless you either want to build your own environment or you want to meet privately. If you do want to use some land then there are many educational organisations from whom you can rent land.

Permissions

Permissions can be a difficult and complex area since, when building and scripting in Second Life, often the objects can be owned by only one avatar unless it is possible to copy, transfer and modify them. It is best to create an institutional avatar which is used by a number of trusted people to log in to build and script for the island.

OpenSim

If using Second Life becomes too complex institutionally, then it is worth considering the open source version, OpenSim. This can be installed and run locally and is under constant development in an attempt to bring it in line with the level of functionality of Second Life. This does require some technical support and know-how but these skills should be well within the remit of your IT/computing department. It is worth remembering though that OpenSim will not have a large ‘community’ of avatars within it, and so some of the social and resource aspects of Second Life will be lost.

Gaining support from senior management

This seems to be very varied across the sector. Some universities are not allowed to use Second Life at all, some have free access and others have restrictions imposed with very clear parameters. Our experience suggests that the freedom to use Second Life across the university with a download option through the university system is the best approach. The only real danger is in loss of intellectual property with staff leaving, but this can be dealt with by having clear guidance relating to permission (as suggested above).

Supporting staff

There are a number of models for supporting staff; the most common one is to use a mentoring system for building or a co-facilitator for teaching. A scheme developed at Coventry University is the ‘Second Life Flying Squad’. This scheme is managed by a project officer with considerable experience in Second Life. The flying
squad itself comprises students who are trained by the project office in building, scripting and guiding staff and are paid by the hour. A member of staff contacts the project officer who works with them on what is required and then allocates a flying squad member to the task. Support is also provided from the Learning Innovation Unit, Coventry University, for staff wanting particular help with pedagogical design for Second Life.

Using external support

There are a number of ways of gaining external support and in particular building support. These are advertised via blogs, the Second Life Educators list and through Second Life itself. However, one of the most reliable companies in the UK is Daden www.daden.co.uk who understand the practices and parameters of higher education and offer a sound and conscientious service.
Useful links and books

Links

Daden: www.daden.co.uk

Problem-based learning in virtual interactive worlds project: www.elu.sgul.ac.uk/preview/blog

Researching the socio-political impact of learning in immersive virtual worlds: http://cuba.coventry.ac.uk/leverhulme

Second Life for Educators: http://secondlifegrid.net/slfe/education-use-virtual-world

White, D. and Goodbosy, D. [2007] Cultural capital and community development in the pursuit of dragon slaying (Massively Multiplayer guild culture as a model for sociable e-learning), ALT-C, Nottingham, September 2007. Watch a video of this talk: http://tallblog.conted.ox.ac.uk/?p=64

Books


Glossary

**Avatar** – the bodily manifestation of one’s self in the context of a 3D virtual world.

**Blogs (weblogs)** – personal websites consisting of regularly updated entries displayed in reverse chronological order. They may be used by learners in PBLonline to evidence their thinking openly to the rest of the team and the e-tutor.

**Chatbots** – characters not controlled by a user within Second Life. The chatbots in this project are also known as ‘Non-Player Characters’ (NPCs) that can be commanded to do certain actions by the facilitator, such as moving around.

**Heads-up display, or HUD** – a display that presents data within Second Life without requiring the user to look away from his or her usual viewpoint.

**Machinima** – a word developed from a combination of machine and cinema; the process of creating films in Second Life so that computer-generated imagery (CGI) is rendered using real-time, interactive 3D engines instead of professional 3D animation software.

**Non-Player Characters (NPC)** – characters not controlled by a user within Second Life. See ‘chatbots’.

**Prims** – ‘primitives’; constituent parts from which objects in Second Life are constructed. There are 15 basic prim shapes (Cube, Prism, Pyramid, Tetrahedron, Cylinder, Hemicylinder, Cone, Hemicone, Sphere, Hemisphere, Torus, Tube, Ring, Tree, Grass) which can be rezzed from the Second Life building interface.

**Problem-based learning** – an approach to learning where the focus for learning is on problem situations, rather than content. Students work in small teams and are facilitated by a tutor.

**Problem-based learning team** – a number of students (4–10) who work together as a defined group.

**Problem-solving learning** – teaching where the focus is on students solving a given problem by acquiring the answers expected by the lecturer, answers that are rooted in the information supplied in some way to the students. The solutions are bounded by the content and students are expected to explore little extra material other than that with which they have been provided, in order to discover the solutions.

**Problem-based learning online** – a generic term which captures that vast variety of ways in which problem-based learning is being used synchronously and asynchronously, on campus or at a distance. It represents the idea that students learn through web-based materials including text, simulations, videos and demonstrations, and resources such as chatrooms, message boards and environments that have been purpose-built for problem-based learning.

**Residents** – those who join Second Life and build, create and undertake activities.

**Rez** – to create or make an object appear.

**Rezzing** – an object can be rezzed by dragging it from an inventory or by creating a new one via the edit window. The term ‘rezzing’ can also be used for waiting for a texture or object to load, for example ‘Everything is still rezzing’.

**Sandbox** – a special place where restrictions to building and scripting are either low or non-existent. This is done to allow residents to build items, or test scripts, without having to get in the way of other residents and is often used as a space to try things out.
**Second Life** – a 3D virtual world created by Linden Labs, set in an internet-based world. Residents (in the forms of self-designed avatars) in this world interact with each other and can learn, socialise, participate in activities, and buy and sell items with one another.

**Virtual Learning Environment (VLE)** – a set of learning and teaching tools involving online technology designed to enhance students’ learning experience, for example Blackboard, WebCT.

**Virtual patients** – simulations or representations of individuals who are designed by facilitators as a means of creating a character in a health care setting.

**Wikis** – server software that allows multiple users to contribute to and edit web page content.
Abbreviations

**CMC** Computer-Mediated Communication

**EPR** Electronic Patient Records

**FRAP** Form for the Reading of the Analysis of Problems

**GPS** Global Positioning System

**HUD** Heads up display

**ICT** Information and Communications Technology

**ISDN** Integrated Services Digital Network

**ISP** Internet Service Provider

**MLE** Managed Learning Environment

**MSN** Microsoft Network

**NPC** Non-Player Characters

**MUVE**s Multi-User Virtual Environments

**MVP** Medbiquitous Virtual Patient

**PBL** Problem-Based Learning

**PBLi** PBL-interactive

**PBLonline** Problem-Based Learning online

**SL/PBL** Second Life/Problem-Based Learning

**SLURL** Second Life Uniform Resource Locator

**VLE** Virtual Learning Environment

**WAN** Wide Area Network
References


Further information about JISC:
Web: www.jisc.ac.uk
Email: info@jisc.ac.uk
Tel: +44 (0)117 33 10789